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Introduction 

Purpose of the guidelines 

At the first glance, communication of the project might seem complicated due to many 
technical requirements, while things will be easier to understand, if we keep in mind 
that all those requirements arise from two main principles that are applied to all projects 
without any exceptions: 

1) All projects must make their outputs freely available to general public. 

2) Support from the European Funds to the project must be acknowledged by carrying 
identity of European Union (EU) and Interreg V-A Latvia–Lithuania Cross Border 
Cooperation Programme 2014–2020 (Programme). 

It is a duty of projects to ensure meeting of the first principle. These Communication 
guidelines of the Programme aim to help you – projects Lead partners (LP) and 
partners (PP) – in meeting the second rule, and explain how the requirements for 
project external communication set in the EC Regulation No 1303/20131 and in the 
Programme Manual (PM) should be applied in practice. So that you would have more 
time to focus on the content of communication, and namely – promotion of your project 
ideas and achievements.  

 

How to use guidelines 

The guidelines are structured in a way, so that the persons responsible for the project 
communication could use it as a hand-book.  

1) 1st Part explains what should be considered when forming entire external 
communication of the project, and what are the main publicity requirements to the 
projects. This section should be read when starting the project, and the general 
requirements described there should be kept in mind. 

2) 2nd Part lists the main requirements of the Programme for specific communication 
activities/measures. It is in a form of check-list, which can be used when 
implementing some communication measures.  

3) Annexes provide resources that can be directly applied in the project 
communication (short dictionary, ready-to-use phrases) and more detailed 
guidelines on the use of the Programme logo and style, icons and colours of 
thematic priorities of the Programme, management of project section on the 
Programme website.  

 

 

                                                

1 Regulation (EU) No 1303/2013 of the European Parliament and of the Council of 17 December 2013 laying down 

common provisions on the European Regional Development Fund, the European Social Fund, the Cohesion Fund, the 
European Agricultural Fund for Rural Development and the European Maritime and Fisheries Fund and laying down 
general provisions on the European Regional Development Fund, the European Social Fund, the Cohesion Fund and 
the European Maritime and Fisheries Fund and repealing Council Regulation (EC) No 1083/2006 

http://latlit.eu/supported-projects/


1. Project communication 

1.1 Things to remember 

When developing project materials, organising events, communicating with target 
public and media keep in mind these things: 

1) Demonstrate project aims and achievements, what changes of the current situation 
will be brought by the project. 

2) Highlight what are the cross-border benefits of those achievements. You must do 
that, because the funding comes from cross-border cooperation Programme.  

3) Acknowledge EU funding. 

 

There are also several practical things about project communication that should not be 
forgotten not only by the person responsible for the project communication, but also 
by each member of the project team. Make sure, that all project partners are aware of 
them: 

- Use the Programme logo and acknowledge EU support during all of your 
activities and on all products of the project. 

- Make photos and/or videos of your activities. You will use them for 
communication and reporting. 

- Keep evidences of each of information materials or items (souvenirs, publications, 
etc.) produced or purchased. They will have to be added to the reports. Samples 
must be kept by the LP and PPs for control and audit purposes.  

- Enter information about the upcoming public events of the project in the calendar 
on the Programme website, send the information about other upcoming events 
(e. g., working meetings) to the assigned JS staff member not later than two 
weeks prior to the event. 

- Always check if your activities meet the project communication requirements. 
Consult JS if in doubt. 

 

1.2 Project communication message 

The communication of the project would be smoother and easier if since the beginning 
of the project you would develop 3–5 main messages stating what are the main 
objectives and expected results of the project, so that whenever you have been asked 
about the project you would be able to explain what you are doing and why. These 
messages are not slogans or advertising texts. Later, around these messages project 
communication can be built. These messages might be changed during the course of 
the project. Several hints for making your messages: 

- Define target public. Most of your target audiences were already identified in your 
project application – these are your main stakeholders. General public is not a 
target audience – if you target everyone you end up speaking to no one.  

- Reflect upon what do you want to say with your message. Think of not only to 
whom you are going to tell about your project, but also why do you want to tell: To 
communicate success of the project? To involve into project activities? To get them 

http://latlit.eu/supported-projects/
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aware about new products and services developed by the project and encourage 
use of them? To share your experiences?  

- Use plain language. The messages should be clear and in plain language. Try to 
imagine, that you are explaining your project to your family members – your 
children or parents. Do not use complicated terms and project jargon, and at the 
same time do not use patronising tone.  

 

1.3 Visual identity of the Programme 

One of the main aims of the project communication set-up is to create a common style 
that would allow clearly to identify the EU support to the project. This is needed for: 

- increasing the public awareness of the EU funding, 

- ensuring transparency of the EU funding.  

 

In case you have doubts if your publicity measures meet the Programme 
requirements – contact JS.  

 

Publicity requirements 

The main principles of the publicity requirements applied to the projects are: 

- Acknowledging EU support by clearly and visibly displaying logo of the 
Programme.  

- Providing main information about the project. How exhaustive it is will depend on 
the type of your publication or activity, space or time available, or technical 
possibilities.  

- Providing information on the financial support from European Regional 
Development Fund (ERDF). 

- Using a disclaimer that the EU is not responsible for the provided information if it 
contains opinion. 

For more specific requirements based on the type of the communication 
activities/measures please see Part II of the guidelines. 

 

Use of Programme logo and colours 

It is mandatory for each project to acknowledge Programme’s support by using the 
Programme logo on all materials and products produced by the project and if 
possible – when implementing project activities. To meet EU publicity requirements, 
the Programme has logo which already contains mandatory communication 
elements – EU emblem (EU flag) and label “European Union”, and reference to the 
ERDF.  

It is possible, that other logos are used in addition to the Programme logo. In such 
cases the following requirements must be respected: 

1) The EU emblem (EU flag), which is a part of the Programme logo, shall have 
at least the same size, measured in height or width, as the biggest of other 
logos. If other logos are bigger than specified, an additional EU emblem (EU 

! 
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flag) should be added, with a size respecting the specifications laid in the Article 
4, paragraph 5 of the Commission implementing regulation (EU) No 821/20142. 

2) At no case other logos used in addition to the Programme logo, shall be larger, 
measured in height or width, than the logo of the Programme. 

 

It is also recommended that the project would use relevant colour of the Programme 
priority it belongs to into the project’s visual identity.  

Annex 3 encloses guidelines on the use of the Programme logo and style, and 
recommendations of use of icons and colours of priorities of the Programme. 

 

1.4 Mandatory communication measures 

The list of the measures/activities provided in the Part II is not complete and should 
not limit projects when choosing communication measures or channels, nor all of the 
listed measures should be implemented by the project – the communication should be 
organized considering the needs of each project.  

Nevertheless, minimal mandatory communication measures that must be 
implemented by each project are defined in PM: 

1. Informative posters at premises of each project partner. 

2. Information about the project on websites of each of project partners. 

3. Regular update of information in special section of the Programme website. 

4. At least two press releases during the project implementation. 

5. Temporary billboard latter replaced by a permanent billboard or plaque in case 
the total costs planned for the infrastructure or (re)construction within the 
project exceeds 500 000 EUR in one site. 

6. In other locations of project investments (for example public spaces, buildings, 
equipped premises) no later than three months after the completion of the 
infrastructure or (re)construction, project partners have to put up a permanent 
plaque or a billboard of significant size, which has to be visible to the public. 
On request of the project the Programme will provide it with plaque as 
described in the Section 2.8. 

 

 

                                                
2 Commission Implementing Regulation (EU) No 821/2014 of 28 July 2014 laying down rules for the application of 
Regulation (EU) No 1303/2013 of the European Parliament and of the Council as regards detailed arrangements for 
the transfer and management of programme contributions, the reporting on financial instruments, technical 
characteristics of information and communication measures for operations and the system to record and store data. 

! 

http://latlit.eu/supported-projects/


2. Requirements for communication activities 

2.1 Websites and social media 

eMS category “DIGITAL ACTIVITIES” 

1. All project partners are obliged to publish information about the project on each 
project partner’s website, if such website exists. It is recommended, that the section 
would be easy to find, with no more than 2-3 clicks from the main page of the 
website of the project partner. 

2. Each project’s website or project section must contain: 

1) Programme logo (see Annex 3).  

It is mandatory to feature the Programme logo visibly on the website or project 
description section without requiring a user to scroll down the page.  
If new website is made from the project funding, the logo must be at the front 
page easy visible without requiring a user to scroll down the page.  
If information about the project is put on the institutions existing website, then 
Programme logo should be visible on the website or project description section, 
without requiring a user to scroll down the page. 

2) Project number, title and acronym. 

3) A short description of the project, its objectives, results, cross-border benefits, 
information about financial support of the ERDF. 

Rather than formally copying project objectives and activities from the 
application reformulate project description into reader-friendly text.  

4) All outputs of the project that are available in electronic format (for example, 
publications, reports of researches, studies, etc.).  

5) A disclaimer that the EU is not responsible for the information provided 
(available in Annex 2). 

6) Link to the Programme website www.latlit.eu. 

7) Link to the official EU website www.europa.eu. 

8) Links to the project’s social media accounts, if relevant. 

3. Use of social media is encouraged.  

1) Project should tag the Programme @LatviaLithuaniaProgramme (on 
Facebook) so that we can easily track and share the information. 

2) Links to the project’s social media accounts should appear in the project section 
of the Programme website, project website (if available) and/or project section 
of project partners websites.  

 

2.2 Project section in the website of the Programme 

eMS category “DIGITAL ACTIVITIES” 

1. Every project must create and regularly update the project information to the 
special section of the Programme website (www.latlit.eu/supported-projects). 
Project lead partner is responsible for the regular update of the information during 
the whole project implementation.  

! 

http://www.latlit.eu/
http://www.europa.eu/
http://www.latlit.eu/supported-projects
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2. Upon start of the project every project must create a project section that contains 
following information in English: 

1) Project number, title and acronym. 

2) Project description in a good language, that contains: 

a) Overall and specific objectives of the project, description of the planned 
results. 

b) Description of existing situation and what the project will change.   

c) Cross-border benefit of the project. 

3) Project implementation period. 

4) ERDF financing. 

5) Project logo (if applicable). 

6) Project pictures (photos, illustrations or other). 

7) Contacts of the Lead partner. 

8) Partnership structure. 

9) Names, addresses and 1-2 sentence descriptions of project objects for 
interactive projects’ map.    

10) Link to the project website (if applicable), or project subsection on websites of 
project partners. 

11) Other relevant information that is considered important by the project itself. 

3. Project must maintain and regularly update project section by updating: 

1) Project description when relevant. 

2) Project news section (all project press releases should be put there). 

3) Social media feeds. 

4) Project events calendar.  

When entering event in calendar please do not forget to choose a project (see 
(Annex 4 for instructions). Add only such events that could be of interest to 
general public or are important events for the project.    

5) Project photos.  

6) Object descriptions in project map. 

7) Project pictures (photos, illustrations or other) and visual materials. 

8) Upload all outputs of the project that are available in electronic format (for 

example, publications, reports of researches, studies, etc.). 

4. Guidelines how to get access rights to the website and to manage project section 
are provided in Annex 4.  

5. Example of project section: http://latlit.eu/coordination-development-and-capacity-
building-of-rescuers-along-baltic-seashore-safety-first-no-lli-92/ 

 

! 
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2.3 Articles, press releases and other information 

eMS category “Publications” 

All publications in media that will be reported as project deliverables, and especially if 
the project pays for publishing of articles or press releases, must contain following 
elements: 

1. Programme logo (see Annex 3). 

2. Project number, title and acronym. 

3. Information about financial support of the ERDF. 

4. A disclaimer that the EU is not responsible for the provided information (available 
in Annex 2) if publication contains opinion. 

5. If possible, provide address of a website where more information is available. 

6. Project must send copies of all press releases and articles to the JS staff member 
responsible for the communication. 

 

It is mandatory for every project to send out at least two press releases during 
the project implementation to the national/ regional and/or local media in Latvia and 
Lithuania and to the JS staff member responsible for the communication:  

1) One at the beginning of the project implementation informing about start of the 
project activities and planned achievements. 

2) One close to the end of the project summarising achievements of the project. 

3) Each of the mandatory press releases must be prepared in Latvian and 
Lithuanian, and/or English and other languages if needed. Distribution of 
information to international media is encouraged.  

 

Press releases should highlight major activities of the project, events, results, cross-
border benefits and it has to be of interest for media and wider public. It is highly 
recommended that press releases are written by the project itself. It is also highly 
encouraged to send press releases for revision to JS relevant information manager 
prior their distribution, especially, if there are doubts regarding meeting Programme 
requirements. 

Some hints for preparing and sending-out of press release: 

 Put the most interesting and important information into the first sentence, and first 
paragraph.  

 Press release should fit into one A4 page (average press release is 500 words). 

 Provide contact details of person who could be approached for more details. 

 Press release text should be e-mail body and also attached to the e-mail.  

 Attach few photos and/or link to video. When sending out photos, indicate that 
these are publicity photos so that media would be able to use them for publishing. 

 

! 
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2.4 Publications 

eMS category “PUBLICATIONS” 

All publications (printed and/or electronic versions of fliers, leaflets, brochures, books, 
monographies, articles in specialised press (e. g. scientific magazines), calendars, 
etc.) must contain: 

1. Programme logo (see Annex 3). 

2. Project number, title and acronym. 

3. Short information about the project that reflects: 

1) Main objectives and goals of the project.  

2) Planned results. 

3) It is also highly recommended to indicate cross-border benefits of project 
achievements.  

Rather than formally copying project objectives and activities from the application 
reformulate project description into short and catchy text. Instead of listing project 
deliverables, administrative and financial information underline the most important 
outcomes and achievements, and cross-border benefits. 

4. Information on financial support of the ERDF. 

5. A disclaimer that the EU is not responsible for the provided information (available 
in Annex 2) if publication contains opinion. 

6. We recommend to include titles and contacts of all project partners and project 
website if available. 

7. It is highly recommended, that all publications produced by the project would be 
also made available on the project websites and/or project sections and shared by 
social media. 

 

2.5 Audio and video materials 

eMS category “DIGITAL ACTIVITIES” and “PUBLICATIONS” 

All audio and video materials (including videos, video or audio clips or radio spots, 
interviews, films, etc.) that will be reported as project deliverables, must contain: 

1. Logo of the Programme (for videos). 

2. Inscription on the funding of the ERDF. 

3. A disclaimer that the EU is not responsible for the provided information (available 
in Annex 2). 

4. Audio phrase  

a. “Project is co-funded by the European Union” in case of spot is less than 
30 secs (available in Annex 2). 

b. Saying that project is funded by the ERDF (available in Annex 2) in case of 
forms longer than 30 secs. 

5. If possible a website where more information is available should be mentioned. 
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6. It is recommended, that all audio and video materials or links to them would:  

a) appear in the project section of the Programme website www.latlit.eu, project 

website (if available) and/or project section of project partners websites, and  

b) would be shared on social media channels with hashtag #latlit or by tagging 

the Programme @LatviaLithuaniaProgramme (on Facebook). 

 

2.6 Events 

eMS category “PUBLIC EVENTS” 

Public events, organised by the project, have to be aimed at communicating of the 
project results and they have to be interesting for target groups and media. 

1. All event promotional materials and documents (agendas, list of participants, hand-
outs, presentations, etc.) must contain 

1) Programme logo (see Annex 3). 

2) Project number, title and acronym. 

The Programme developed list of participants which is highly recommended to 
be used during the events. It can be downloaded from the Programme website 
latlit.eu/how-to-implement/.  

2. The EU flag and/or movable stands or roll-ups etc. of the projects, containing the 
Programme logo has to be displayed at all events, financed by the project. 

3. During the event the Programme logo has to be placed in a clearly visible place 
and photos of the event showing the Programme logo placement should be added 
to the relevant progress report. 

4. Information on the upcoming public events of the project has to be entered in the 
calendar on the Programme website www.latlit.eu  not later than two weeks before 
the event.  

5. The information about other events (e.g. working meetings), has to be sent to the 
assigned JS staff member via eMS not later than two weeks before event. 

6. Lists of participants, photos from events, all related materials (invitations, agendas, 
hand-outs, etc.) of the event must be presented for reporting purposes, and 
originals saved by the PP for auditing and control purposes. 

 

The projects are encouraged upon request by the MA/JS to participate in the 
Programme organised events (e. g. Programme Annual events, European 
Cooperation Day, Balts Unity Day). The projects are also invited to plan and 
organise their own activities for the European Cooperation Day. More information 
about the European Cooperation Day can be found on the website www.ecday.eu.  

 

! 

! 

http://latlit.eu/supported-projects/
http://latlit.eu/how-to-implement/
http://latlit.eu/supported-projects/
http://www.latlit.eu/
http://www.ecday.eu/
http://www.ecday.eu/
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2.7 Informative posters 

eMS category “PUBLICATIONS” 

All informative posters must contain: 

1. Programme logo (see Annex 3). 

2. Project number, title and acronym. 

3. The main objective of the project. 

Instead of listing project deliverables, administrative and financial information 
underline the most important outcomes and achievements, and cross-border 
benefits. You should reformulate them into short and catchy text. Readers of it 
should be able to see what the project is about, and how it contributes to the 
specific objectives by which it is supported. 

4. A disclaimer that the EU is not responsible for the provided information (available 
in Annex 2) if poster contains opinion. 

5. Information on financial support of the ERDF.  

6. We recommend including titles and contacts of all project partners and project 
website if available. 

7. It is highly recommended, that all posters would also be made available in 
electronic version on the project website and/or project sections. 

The Programme developed a template of the project informative poster (see Annex 5). 
Nevertheless, the projects may develop and use their own design if mandatory 
requirements are met. 

It is mandatory, that all project partner organisations display at least one 
informative poster (minimum size A3) at a location readily visible to the public in 
their premises, for example, at the entrance area of the building. This means that 
it must be highly likely that an average visitor will see the poster. The information 
must be written and permanent. This includes paper posters, roll-ups, banners, 
boards, etc. with the minimum size of A3 format. Electronic displays do not match 
these requirements.  

Only project partners, placing temporary or permanent plaques or billboards, as 
described in section “Marking of infrastructure objects” are not obliged to display 
an informative poster. 

 

2.8 Marking of infrastructure objects 

eMS category “PROMOTIONAL MATERIALS” 

At each investment location, in case in one site the total costs planned for the 
infrastructure or (re)construction within the project exceed 500 000 EUR, 
project must: 

1. Put up a temporary billboard of significant size, which has to be visible to the public.  

2. Put up a permanent plaque or a billboard of significant size, which is visible to the 
public no later than three months after the completion of the infrastructure or 
(re)construction. It cannot be removed for at least five years after the final payment 
to the project has been made. 

! 
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3. At least 25 % of plaque or billboard must be occupied by this information: 

1) Programme logo (see Annex 3). 

2) Project number, title and acronym. 

3) Objective of the project. 

Instead of listing project deliverables, administrative and financial information 
underline the most important outcomes and achievements, and cross-border 
benefits. You should reformulate them into short and catchy text. Readers of it 
should be able to see what the project is about, and how it contributes to the 
specific objectives by which it is supported. 

4) Information on financial support of the ERDF. 

 

In other locations of project investments (for example public spaces, buildings, 
equipped premises) project must: 

1. No later than three months after the completion of the infrastructure or 

(re)construction, to put up a permanent plaque or a billboard of significant size, 

which has to be visible to the public. It cannot be removed for at least five years 

after the final payment to the project has been made. 

2. On request of the project the Programme will provide it with plaque containing 

general, no project specific information. However, projects are recommended to 

develop project specific plaque or billboard of which at least 25 % is occupied by 

following information: 

1) Programme logo (see Annex 3). 

2) Project title, acronym and project number. 

3) If space allows – objective of the project. 

Instead of listing project deliverables, administrative and financial information 
underline the most important outcomes and achievements, and cross-border 
benefits. You should reformulate them into short and catchy text. Readers of it 
should be able to see what the project is about, and how it contributes to the 
specific objectives by which it is supported. 

4) Information on financial support of the ERDF. 

 

The Programme has developed a template of the plaque to mark infrastructure objects 
(see Annex 6). The projects may develop their own design of the plaque or billboard, 
if mandatory requirements are met. 

 

2.9 Labelling of equipment 

1. Equipment and other purchases made within the project must be labelled with the 
Programme logo, which cannot be removed for at least five years after the final 
payment to the project has been made.  

2. In case many items purchased within the project are located in one premise and 
they are not movable, it is recommended to display an informative plaque in the 
premise. 

3. Stickers and plaques with the Programme logo are available from the JS on 

! 
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request. The LP should request JS for the stickers and plaques on behalf of all 
project partners.  

4. If stickers and/or plaques of specific size and/or material are required, the project 
must produce them individually. Requirements on the use of the Programme logo 
must be followed (see Annex 3). 

 

2.10 Other promotional materials 

eMS category “PROMOTIONAL MATERIALS” 

Promotional materials should be limited to mainly office and event materials. The 
promotional materials should be clearly linked to awareness-raising of the project 
overall objective. 

It is difficult to list all possible cases of produced materials and what kind of 
requirements should be applied. However, the projects must put their efforts to 
acknowledge EU support and to use logo of the Programme (see Annex 3), and 
depending on the technical possibilities to provide information about the project. If you 
have doubts on what requirements are applicable do not hesitate to contact JS. 

Only gifts related to promotion, communication, publicity or information are eligible 
expenditures. Requirements of the PM section 9.2 Eligibility of costs must be 
respected and threshold of 50 EUR per gift must not be exceeded.  

! 



3. References 

3.1 Documents 

Programme Manual for the respective call for proposals and direct award. 

 

EC Regulation No 1303/2013 Article 115 and Annex XII set-ups rules concerning the 
information measures for beneficiaries. 

http://eur-lex.europa.eu/legal-content/en/TXT/?uri=CELEX%3A32013R1303 

 

Commission implementing regulation (EU) 821/2014 (Implementing Act), Articles 3, 4 
and 5 hold the technical characteristics for displaying the Union emblem and the 
reference to the Fund or Funds supporting the operation as well as the instructions for 
creating the emblem and a definition of the standard colours. 

http://eur-lex.europa.eu/legal-content/EN/ALL/?uri=CELEX:32014R0821 

 

3.2 Useful links  

Programme website: www.latlit.eu 

 

Official EU website: www.europa.eu 

 

Programme FB page: www.facebook.com/LatviaLithuaniaProgramme/ 

 

The Programme logo files, icons of the Programme priorities, project information 
plaque template can be downloaded from www.latlit.eu/how-to-implement/ 

 

Project section of the Programme: www.latlit.eu/supported-projects/ 

 

More about European cooperation day: www.ecday.eu  

 

 

http://www.latlit.eu/
http://www.europa.eu/
http://www.latlit.eu/how-to-implement/
http://www.latlit.eu/supported-projects/
http://www.ecday.eu/


Annex 1. Short dictionary 

English Latvian Lithuanian 

European Union Eiropas Savienība Europos Sąjunga 

European Regional 
Development Fund (ERDF) 

Eiropas Reģionālās 
attīstības fonds (ERAF) 

Europos regioninės plėtros 
fondas (ERPF) 

European Territorial Co-
operation 

Eiropas teritoriālā sadarbība Europos teritorinis 
bendradarbiavimas 

efficient public services efektīvi publiskie 
pakalpojumi 

efektyvios viešosios 
paslaugos 

employment and labour 
mobility 

darbaspēka mobilitāte un 
nodarbinātība 

užimtumas ir darbuotojų 
judumas 

improved quality of living 
through efficient public 
services and administration 

dzīves kvalitātes uzlabošana 
ar efektīvu publisko 
pakalpojumu un valsts 
pārvaldes palīdzību 

geresnė gyvenimo kokybė 
sustiprinant viešųjų 
paslaugų ir administravimo 
efektyvumą 

Interreg V-A Latvia–
Lithuania Cross Border 
Cooperation Programme 
2014–2020 

Interreg V-A Latvijas – 
Lietuvas pārrobežu 
sadarbības programma 
2014. – 2020.gadam 

2014–2020 m. Interreg V-A 
Latvijos ir Lietuvos 
bendradarbiavimo per sieną 
programa 

Interreg V-A Latvia–
Lithuania Programme 2014–
2020 

Interreg V-A Latvijas – 
Lietuvas programma 2014. – 
2020.gadam 

2014–2020 m. Interreg V-A 
Latvijos ir Lietuvos 
programa 

Latvia – Lithuania 
Programme 

* such short title of the 
Programme should not be 
used in official 
communication 

Latvijas–Lietuvas 
programma 

* šāds saīsināts 
programmas nosaukums 
nedrīkst tikt izmantots 
oficiālajā komunikācijā 

Latvijos ir Lietuvos 
programa 

* toks programos 
pavadinimo trumpinys 
neturėtų būti naudojamas 
oficialiojoje komunikacijoje 

social inclusion sociālā iekļaušana socialinė įtrauktis 

social inclusion as a 
precondition of territorial 
development 

sociālā iekļaušana kā 
teritoriālās attīstības 
priekšnoteikums 

socialinė įtrauktis kaip 
išankstinė teritorinės plėtros 
sąlyga 

support to labour mobility 
and employment 

atbalsts darbaspēka 
mobilitātei un nodarbinātībai 

parama darbuotojų judumui 
ir užimtumui 

sustainable and clean 
environment 

ilgtspējīga un tīra vide tvari ir švari aplinka 

sustainable and clean 
environment through 
cooperation 

ilgtspējīga un tīra vide ar 
sadarbības palīdzību 

tvari ir švari aplinka, kuriama 
bendradarbiaujant 



Annex 2. Useful phrases and texts 

These are proposed phrases and texts, that you can use in your communication upon 
need of your project. 

About the Programme 

EN The Interreg V-A Latvia – Lithuania Cross Border Cooperation Programme 2014-
2020 aims to contribute to the sustainable and cohesive socio-economic 
development of the Programme regions by helping to make them competitive and 
attractive for living, working and visiting. 

LV Interreg Latvijas – Lietuvas pārrobežu sadarbības programmas 2014. – 
2020.gadam mērķis ir sekmēt Programmas reģionu ilgtspējīgu sociālekonomisko 
attīstību, palīdzot tos padarīt konkurētspējīgākus un pievilcīgākus dzīvošanai, 
uzņēmējdarbībai un tūrismam. 

LT 2014–2020 m. Interreg V-A Latvijos ir Lietuvos bendradarbiavimo per sieną 
programa siekia prisidėti prie darnaus programos teritorijos vystymosi padėdama 
jai tapti patrauklia ir konkurencinga vieta gyventi, dirbti ir apsilankyti. 

About EU funding 

EN This project is funded by the European Union 

LV Šo projektu finansē Eiropas Savienība 

LT Šį projektą finansuoja Europos Sąjunga 

On financial support of the ERDF 

EN Total projects size is <amount> EUR. Out of them co-funding of European 
Regional Development Fund is <amount> EUR. 

LV Kopējās projekta izmaksas ir <summa> EUR. Projekta līdzfinansējums no Eiropas 
Reģionālās attīstības fonda ir <summa> EUR. 

LT Visas projekto biudžetas – <skaičius> Eur. Iš jų – bendrasis Europos regioninės 
plėtros fondo finansavimas – <skaičius> Eur. 

Disclaimer, stating that the EU is not responsible for the information provided 

EN This <document/publication/article> has been produced with the financial 
assistance of the European Union. The contents of this 
<document/publication/article> are the sole responsibility of <name of the project 
partner> and can under no circumstances be regarded as reflecting the position of 
the European Union. 

LV Šis <dokuments/publikācija/raksts> ir sagatavots ar Eiropas Savienības finansiālo 
atbalstu. Par šī<dokumenta/publikācijas/raksta> saturu pilnībā atbild <projekta 
partnera nosaukums>, un tas nekādos apstākļos nav uzskatāms par Eiropas 
Savienības oficiālo nostāju. 

LT Šis <leidinys/dokumentas/straipsnis> parengtas naudojant Europos Sąjungos 
finansinę paramą. Už šio <leidinio/dokumento/straipsnio> turinį atsako <projekto 
partnerio pavadinimas>. Jokiomis aplinkybėmis negali būti laikoma, kad jis atspindi 
Europos Sąjungos nuomonę.  
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Audio text about project funding 

EN This <broadcast, interview> has been prepared as part of the project <title of the 
project>, which is funded by the European Union under the Interreg V-A 
Latvia – Lithuania Programme 2014-2020 

LV Šis <raidījums, intervija> ir tapis projekta <projekta nosaukums> ietvaros, ko 
finansē Eiropas Savienības Interreg Latvijas – Lietuvas programma 2014. – 
2020.gadam.  

LT <Laida, interviu> parengta(s) įgyvendinant projektą <projekto pavadinimas>. 
Projektą finansuoja 2014–2020 m. Interreg V-A Latvijos ir Lietuvos programa. 

 



Annex 3. Programme logo and style guide  

I. Programme logo 
Elements of the Programme logo 

The Programme logo consists of the 
following five elements:  

 Interreg logo,  

 EU emblem and label “European 
Union”, 

 Programme title, 

 Reference to the fund “European Regional Development Fund”, 

The graphic symbol, representing the colours of the national flags of Latvia and Lithuania. 

Interreg 

“Interreg” is a name that is shared by every European Territorial Cooperation programmes in 
order to make every programme instantly recognizable as a part of a global network working 
in a joined effort. 

The graphic symbol 

The graphic symbol is what gives the Programme it’s visual individuality. It is inspired by the 
colours of national flags and the whirling, forward-moving shape symbolises the very objective 
of the Programme — to contribute to a sustainable and cohesive socio-economic development 
of the Programme regions by helping to make them more competitive and attractive for living, 
working and visiting.  

 

 

Size of the Programme logo 

The size of the Programme logo must be such that it is possible to read text in the 
Programme logo.  

 

The minimum recommended withdraw 
size of the Programme logo is 60 mm.  

In cases when the minimum 
recommended withdraw size of the 
Programme logo may not be used it is 
recommended to use minimised version 
of 47 mm (all versions of logos have 
minimised version).  

However, it is allowed to use also 
smaller versions of logo respecting 
requirement that it must be possible to 
read text in the Programme logo. 

 

 

 

! 

The minimum recommended withdraw 
of the programme logo is 60 mm 

47 mm minimum recommended 
withdraw for minimised version 



 

20 

 

Use of other logos 

It is possible, that other logos will be used in addition to the Programme logo. The following 
requirements must be respected: 

1) It must be ensured, that the EU emblem (flag), which is a part of the Programme logo, 
shall have at least the same size, measured in height or width, as the biggest of other 
logos. If other logos are bigger than specified, an additional EU emblem (flag) should be 
added, with a size respecting the specifications laid in the Commission implementing 
regulation (EU) No 821/2014 (article 4, paragraph 5). 

2) At no case other logos used in addition to the Programme logo, shall be larger, measured 
in height or width, than the logo of the Programme. 

 

 

 

Background colour of logo 

The logo of the Programme must be placed on white background. Coloured backgrounds 
should be avoided, and the only exception are very light colours, that do not reduce visibility 
of the logo.  

If the logo needs to be placed on a dark background, it has to be on a white rectangle, with its 
size matching at least the clear space as specified below. 

 

 

Clear space 

The logo is surrounded by a clear space area that defines the minimum distance to other 
elements such as other logos, pictures, texts or any other design elements.  

Always use the digital logo files provided and do not try to recreate or modify the logo in any 
way. 

 

 

 

One measurement unit = the letter “e” 

 

 

 

 

 

 

 

 

 

http://latlit.eu/how-to-implement/
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Monochrome versions 

Greyscale logo 

For single colour reproductions, a 
greyscale version of the logo should be 
used. This version should only be used 
whenever full colour is not available.  

 
 

Black and white logo 

The black and white logo should only be 
used if there is no possibility to use 
greyscale. 

  

It is recommended not to invert the logo or use the logo in any other colour than the 
standard full colour version or in greyscale on monochrome applications.  

 

Language variations 

MIXED languages:  

This is the main Programme logo, 
which can be used on all information and 
communication materials, documents and 
outputs. 

 
 

LATVIAN language: 

This logo option can be used on 
documents and publications, which are 
prepared in Latvian language. 

  

LITHUANIAN language: 

This logo option can be used on 
documents and publications, which are 
prepared in Lithuanian language. 

  

 

Download logos 

Always use the digital logo files provided and do not try to recreate or modify the logo. 
The logo of the Programme integrates mandatory publicity requirements of the EU funds: 
EU emblem (flag) and label “European Union”, and reference to the ERDF. 

All versions of logos can be downloaded from the Programme website (latlit.eu/how-to-
implement/). If you have difficulties to download files, please contact JS. 

! 

! 

http://latlit.eu/how-to-implement/
http://www.latlit.eu/how-to-implement/
http://www.latlit.eu/how-to-implement/


 

22 

 

Incorrect use of logo 

1. Do not rotate the logo.   2. Do not distort logo in any way. 

  

3. Do not use any effects on the logo. 4. Do not use outlines around the logo. 
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II. Icons of the Programme priorities 

Aiming to underline integrity of their projects with the priorities of the Programme the projects 
might also use Icons for the Programme priorities. These icons were developed for all Interreg 
Programmes.  

It is also advised that the colour of the project name would be the colour of the Programme 
priority as specified in section III. 

Standard files of icons can be downloaded from the Programme website.  

 

Standard appearance (positive) 

    

SUSTAINABLE AND CLEAN 
ENVIRONMENT 

EMPLOYMENT AND 
LABOUR MOBILITY 

SOCIAL INCLUSION EFFICIENT PUBLIC 
SERVICES 

 

Negative appearance 

   

    

SUSTAINABLE AND CLEAN 
ENVIRONMENT 

EMPLOYMENT AND 
LABOUR MOBILITY 

SOCIAL INCLUSION EFFICIENT PUBLIC 
SERVICES 

 

http://latlit.eu/how-to-implement/


III. Colours of the Programme 

Colours to be used for the Programme logotype 

Interreg and EU colours 

    

Reflex blue 
Pantone: Reflex Blue 
CMYK: 100/80/0/0 
RGB: 0/51/153 
HEX: 003399 
WebSafe: 003399 

Light Blue 
Pantone: 2716 C/U 
CMYK: 41/30/0/0 
RGB: 159/174/229 
HEX: 9FAEE5 
WebSafe: 9FAEE5 

Yellow 
Pantone: Yellow 
CMYK: 0/0/100/0 
RGB: 255/204/0 
HEX: FFCC00 
WebSafe: 333333 

 

Solid colours from the logo symbol 

    

LV Dark Red 
Pantone: 201 C/U 
CMYK: 24/97/70/20 
RGB: 163/31/52 
HEX: a31f34 
WebSafe: 993333 

LT Red 
Pantone: 180 C/U 
CMYK: 25/100/100/0 
RGB: 193/39/45 
HEX: c1272d 
WebSafe: cc3333 

Green 
Pantone: 349 C/U 
CMYK: 100/55/100/0 
RGB: 0/106/68 
HEX: 006a44 
WebSafe: 006633 

Yellow 
Pantone: 1235 C/U 
CMYK: 0/30/100/0 
RGB: 235/185/19 
HEX: fdb913 
WebSafe: ffcc00 

Accent colours 

The blue colours are to be used as a colour accents in visual materials. 

  

Reflex blue 
Pantone: Reflex Blue 
CMYK: 100/80/0/0 
RGB: 0/51/153 
HEX: 003399 
WebSafe: 003399 

Light Blue 
Pantone: 2716 C/U 
CMYK: 41/30/0/0 
RGB: 159/174/229 
HEX: 9FAEE5 
WebSafe: 9FAEE5 

 

 
Colours of priorities of the Programme 

It is recommended that project belonging to one of the four priorities of the Programme would 
use the colours in project‘s visual identity.  

Sustainable and 
clean environment 

Employment and 
labour mobility 

Social inclusion Efficient public 
services 

    

Pantone: 382 U 
CMYK: 49/0/99/0 
RGB: 152/194/34 
HEX: 98c222 

Pantone: 1665 U 
CMYK: 2/71/72/0 
RGB: 234/102/71 
HEX: ea6647 

Pantone: 513 U 
CMYK: 43/70/12/0 
RGB: 163/98/152 
HEX: a36298 

Pantone: 3145 U 
CMYK: 87/32/35/16 
RGB: 60/116/134 
HEX: 3c7486 



IV. Fonts of the Programme 

 

Headings 
and 

text highlights 

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 

 
Montserrat is the typeface for headlines and text highlights. 
Font can be downloaded here: 
http://www.fontsquirrel.com/fonts/montserrat  

 

Body text ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 

 
Open Sans is typeface for body text. Font can be downloaded 
here:  
http://www.fontsquirrel.com/fonts/open-sans 

 

Body text 
alternative 

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 

 
Arial can be used as an alternative when Open Sans is 
unavailable as it is available on most systems. 

 

 
 

http://www.fontsquirrel.com/fonts/montserrat
http://www.fontsquirrel.com/fonts/open-sans


Annex 4. Management of the project section in the 
Programme website 

 

To get access rights please send an e-mail to: janis.vanags@varam.gov.lv and state 
your project.   

Open website administration panel http://latlit.eu/wp-admin and sign in.  
 
 
 
SUPPORTED PROJECTS 

To add a new project, open the section Projects → Add New. 

 

 

Enter the project title. 

 

 

In text editor enter all necessary information: 

Project description, Project goal, Project idea, … 

To enter video / table / image in a project or set visual text changes, see the section 
TEXT DECORATION . 

 

mailto:janis.vanags@varam.gov.lv
http://latlit.eu/wp-admin/
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Project Duration block. 

Project Duration field need to mark two fields: From, To – need to set up date from 
calendar.  

ERDF Financing field need to enter financing. 

 

 

 

Background image/jpg and Front image/png, need to be set from media, we need to 
press the button Add Image. To understand how to add or set an image, see the 
section MEDIA. 

 

 

Lead partner and Thematic objectives must be chosen from the list – partners and 
thematic objectives. In each field can be chosen several values. If it’s not in the list, 
partner has to be first added here: http://latlit.eu/partner-search/    

 

 

To create a partner structure use Second level field. At first press on Add row button. 

 

http://latlit.eu/partner-search/
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Choose second level partner from the list. If it’s not in the list, partner has to be first 
added here: http://latlit.eu/partner-search/. Then in Third level column press on Add 
Row button. 

 

 

Select all third level partners to second level, if necessary add new one second level 
partner press on correct Add Row button. 

 

 

If Partner, which Supported projects Editor need to choose, is not on the list, then he 
need to register in Partner Search (http://latlit.eu/partner-search/). When LATLIT 
Administrator will confirm Partner he will be on the Partners list.  

At the end of page can set social network settings – Twitter, Instagram, Facebook. 
Need to enter name and feed to show. 

 

 

When all information is entered, press the button Publish. 

 

 

 

http://latlit.eu/partner-search/
http://latlit.eu/partner-search/
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INTERACTIVE MAP 

To add points to map, need to open Addresses tab and then need to press on Add 
Address button. 

 

After pressing on button displays empty row where: 

 In first column need to enter object name. 

 At second column object full address needs to be entered. If valid address has 

been entered (Google maps can find it) – next two fields (latitude and longitude) 

fills in automatically. 

 At third column latitude needs to be entered. 

 At fourth column longitude needs to be entered. 

 At fifth column 1-2 sentence description what will be done in the object needs to 

be entered. 

This way, pressing on Add Address button, can enter several objects addresses. 

 

When all information is entered, press the button Publish. 

 

 

 

PROJECT NEWS 

To add new news, open a section Posts → Add New. 

 

Enter the news title. 
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In a text editor, first – enter a short description of the news without pictures. How we 
can do it? 

Enter a short description, and then press the button Insert → Insert Read More Tag. 
(See in the picture) 

 

 

After pressing the button Insert → Insert Read More Tag we can enter the full 
description of the news (with pictures, tables and video). To make a visual change in 
text and/or enter video, table, link into text, look at the section TEXT DECORATION. 

 

 

Scroll down to Featured image, to set featured image for news, press the button Set 
featured image. 

How to set featured or add images to media and after that set it, see the chapter 
MEDIA. 

 

 

Scroll up to the Tags block. 

In this block we can add the news tags. At the same time, after each tag we can add 
several tags and enter “,” (comma, after and before comma doesn’t need to enter 
spaces, example: news,link,Latvia). 

When all tags are entered, press the button Add. 
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Scroll up to the Categories block. 

In this block mark the category Project News. 

 

Scroll up. We can set the publication date, in Publish press on Edit. 

 

Set the correct date and press OK. 

 

When all information is added, press the button Publish. 

 

After publishing, after text editor shows an extra field news in projects, where you need 
to choose in what project shows news. 

 

When project is chosen, need to press on Update button. 

 

 

 

PROJECT EVENTS 

To add a new event, open the section Events → Add Event. 

 

Enter title of the event. 
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When – set  event date. 

From – choose the start date. 

To – choose the event end date. 

If the event lasts only one day,  start and end date will be the same. 

Then set event time, if event last all day – mark All day. 

 

 

In text editor enter event description. To make visual changes in description, see the 
section TEXT DECORATION. 

 

 

In Event Categories block need to set a category Project events.  
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Where block. 

If event does not have a physical location, mark the field This event does not have a 
physical location.  

If event has a physical location, is necessary to fill the next fields: 

Location Name, Address, City / Town and Country (choose from drop menu). 

 

When all information is added, press the button Publish. 

 

After publishing, after that the Bookings/Registration block shows an extra field events 
in projects, where you need to choose a project. 

 

When project is chosen, press on Update button. 

 

 

 

TEXT DECORATION 

In text editor we can make a visual text change. Visual change: 

1. Text align –  need to use this buttons; 

2. Text decoration (bold, italic, underline) –  need to use this buttons; 

3. To make a list –  need to use this buttons; 

4. To enter a link from YouTube website – in text editor enter YouTube link 
(example, if YouTube link is https://www.youtube.com/watch?v=XCUhYidrTAU, 
this link is necessary to paste in the text editor); 

https://www.youtube.com/watch?v=XCUhYidrTAU
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5. We can change text heading: 

a. First, enter the text; 

b. Second,  mark the necessary text; 

c. Third, click on Format → Formats → Headings → Choose the necessary 
heading. 

 

6. To enter the table: 

a. First, click on the Table → Insert table → mark the necessary area, 
number of columns and rows; 

 

b. Second, enter the content; 

c. Mark up the first row, then click on the Table → Row → Table row 
properties; 
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d. Row type field  change – choose from Body to Header, and press the 
button OK. 

 

7. To add a link into the text: 

a. Mark up necessary word or phrase, and click on symbol ; 

b. URL field – enter / paste link; 

c. Link Text – if text is highlighted, this field is automatically generated; 

d. We can mark the field Open link in a new tab. 

e. When all information is entered, press the button Add Link. 

 

8. To enter the document: 

a. Ahead of text editor is placed the button Add Media. Press on it. 

 

b. How to add document to media, see in the section ADD NEW FILE TO 
MEDIA. Find the necessary document, in right side is URL field – copy 
link which is entered in this field. 
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c. Then close the pop up window, text editor on panel and click on link 

symbol ; 

d. URL field – paste the document link; 

e. Link Text – enter the document title; 

f. We can mark the field Open link in a new tab. 

g. When all is information entered, press the button Add Link. 

 

9. To insert image into text: 

a. First, press the button Add Media. 

b. Second, if image isn’t added in media, how to do see in the section 
MEDIA. If the image is added in media, find this image → in right side 
scroll down to title Attachment display setting. In this section set image 
alignment in Alignment field, then set the image size in field Siz. 

c. When settings are set, press the button Insert into post. 
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MEDIA 

1. ADD NEW FILE TO MEDIA 

To add a new file (image / document) in media, switch to the section Upload Files. 

 

Then there are two ways how we can add the image / document: 

1. Open the folder, where is placed a file, clink on the necessary file and with 
mouse help drop file in administration open pop up window. 

 

2. Click on the button Select Files. On computer find the folder with necessary 
file, click on file and then click on the button Open. 
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When a file is added we can specify a file category. In the right side mark the 
necessary category. 

 

 

 

2. SET IMAGE FROM MEDIA 

To enter a document file into page / post, see the section TEXT DECORATION. 

To set an image, find the necessary image – click on it, and press on the button: Insert 
into post, Set featured image, … 
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Annex 5. Template of project poster 

- Colours of the Programme, that are defined in the Programme logo and style guide 
(Communication guidelines Annex 3).  

- Project title should be written in the colour of the Programme priority addressed by 
the project.  

- The template is developed to be print on A3 size. 

- Plaque templates are available in Latvian and Lithuanian. 

- File of the project poster template can be downloaded from  
www.latlit.eu/how-to-implement/ 

 

 

 

  

 

 

 

http://www.latlit.eu/how-to-implement/


Annex 6. Template of plaque to mark 
infrastructure objects 

- Colours of the programme, that are defined in the Programme logo and style guide 
(Communication guidelines Annex 3).  

- Project title should be written in the colour of the Programme priority addressed by 
the project.  

- Plaque templates are available in Latvian and Lithuanian. 

- File of the project poster template can be downloaded from  
www.latlit.eu/how-to-implement/. 

 

 

 

 

http://www.latlit.eu/how-to-implement/


Annex 7. Failing to meet communication 
requirements 

Section 8 of the PM stipulates amounts of corrections that are being applied in case of 

failure to apply communication requirements of the Programme. 

 

If information and communication requirements are not observed or are partly 

observed, related project outputs (events, purchases, publications, etc.) may be 

considered as ineligible or partly ineligible and the respective ERDF co-financing 

may be reduced. 

In case it is not possible to quantify the financial amount of ineligible costs the following 

principles shall be applied to determine the amount of financial correction: 

Type of mistake 
Amount 

of 
correction 

Publicity requirements have not been fulfilled, but the publicity 
elements can be added 

0-10% or 
warning 

Technical mistakes related to publicity requirements (mistakes with 
colours, size or similar) 

10% 

Elements of the publicity requirements missing 25% 

No publicity requirements have been fulfilled, and no corrective 
measures are possible 

100% 

 

 

! 


